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1. Installation 
 
The latest version of Pi Toolbox can be downloaded from the Cosworth website along with 
other Motorsport software. https://www.cosworth.com/products/toolbox/?cat=software 
 

 
 
Supported Operating Systems 
Microsoft Windows 10 (32 or 64-bit) 
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2. Licensing 
 
2.1 Configuring a Pi Toolbox License 
 
Licencing for Pi Toolbox is configured from the Cosworth Software Licensing Configuration 
Tool. This is accessed from Pi Toolbox: Help > Configure Licensing. 
 

 
 
If you have purchased a Plus, Pro or Ultra License you will have been sent a Product Key by 
Cosworth, which can be added to Pi Toolbox by click the button in the Cosworth 
Software License Configuration Tool. This is also true for the Lite version, please see below. 
 

 
 
Paste the Product Key into the box and click ‘Add’ and you license will be activated to use 
in Pi Toolbox. 
Alternatively, if you have not purchased a Pi Toolbox license, a free ‘Lite’ license can be 
requested from the Cosworth website, and added to Toolbox using the same steps as 
above. 
To request a Lite license, follow this link and enter your details in the box shown below:  
https://www.cosworth.com/products/toolbox/?cat=software 
 

 
 

If you would like to purchase a Plus, Pro or Ultra License, or would like more information 
about the licenses available, please contact sales@cosworth.com 
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2.2 Transferring a Pi Toolbox License between computers 
 
It is possible to transfer Licenses between different computers. The license can only be used 
on one computer at a time. 
The first step is to generate a recipient file on the PC the license is being transferred to: 

• Click on the Import button  in the Cosworth Software Licensing Configuration 
Tool. 

• Click ‘Generate Recipient File’ to create a .id file. 
• Save this on to a USB stick and move this over to the PC which has the license on it. 

 

 
 
Next transfer the license to the recipient file that was generated: 

• Click the Transfer button in the Cosworth Software Licensing Configuration 
Tool on the computer which has the license on and pick the Recipient File .id on the 
USB Stick. 

• Click the ‘Generate Transfer File’ button and save this .h2h file on to the USB stick. 
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Import the license on the PC the license is being transferred to: 

• On the PC the license is being transferred to, click the Import  button in 
Cosworth Software Licensing Configuration Tool. 

• Find the .h2h file on the USB stick and click import. 
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3. Getting Started 
 
3.1 Quick Start Guide 
The Quick Start Guide is to help new users quickly create displays and plot data.  
 
When Pi Toolbox is first opened, a default Worksheet is provided with a single Task included. 
However, the following steps assume that you are starting with an empty Worksheet. To 

open an empty worksheet, click the new button  ( ) on the toolbar. 
 
3.1.1 Create a Task 

Go to the task window of the Explorer ( + ) and select:  > Add Task. Name the 
task by double-clicking 'Name' in the Details pane and overtyping the default name. Press 
Enter or click away from the edit box to accept the name. 
 

 

 
 

3.1.2 Load an Outing 

Highlight the task and select: > Add Outing. Browse for a PDS (Pi Dataset) in the Load 
outing dialog. 
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3.1.3 Select Laps 
When an outing is initially connected to a task, the data from the fastest lap of the outing 
is loaded. 
 
Highlight the outing whose laps are selected. 

Select:  > Select and choose Regions to open the Select dialog (Alternatively double-
click the outing or press Enter). 
 

 
 
The Select dialog lists all the laps contained in the outing. 
Select the required lap or laps. 
 

 
 
To highlight a group of laps: Click the first in the group, then Shift + click the last. 
Click Select. 
 

Alternatively, you can choose to select all laps with the All Regions ( ) option or the 

fastest lap with the Fastest Lap ( ) option. 
 
3.1.4 Add a display to a worksheet 
Click the Insert Display button ( ) on the toolbar and select a display type from the list. 
Note that this button remembers the last display type added and shows the appropriate 
icon. 
 
3.1.5 Connect the display to a task 
In order for the display to plot data, it must be connected (or associated) to a task. 

To do this click the 'No Task' icon ( ) in the top left of the display title bar and from the 
dropdown list of available tasks, choose the task you have created. 
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3.1.6 Select channels to display 
Go to the Channels Explorer - press  +  - to see the channels in the outing. With 
your display in focus, double-click the channels that you want to appear. The channels 
selected will appear in the lower pane of the Explorer and the data will appear on the 
display. 
 

 
 
In the Channels Explorer, all channels associated with the outing dataset loaded, are listed 
in the Available Channels list. 
 
To apply a filter to the list of Channels, with the Explorer in focus, type in the first letter of the 
channels you are interested in. Typing more characters filters the list more. 
 

 
 

To remove a filter character press 'Backspace'. To remove the filter press 'Esc'. 
More advanced filters can be applied by using a mix of normal and wildcard characters. 



 

11 

 
Wildcard characters: 
* Any character or group of characters      ? Single character      ?? Two characters etc. 
To enter a wildcard character press  +  +   or   +  +  
 
Filter: TE 
Comments: 
Finds channels 
beginning 'TE' 
and channels 
with first word 
starting with 'T' 
and second 
word starting 
with 'E'. 'TEW' 
would find Temp 
Engine Water. 
Results: 
Temp Brake FL, 
Temp Brake FR, 
Temp Brake RL, 
Temp Brake RR, 
Temp Clutch, 
TH Error, 
Etc. 

Filter: C*E 
Comments: 
Finds channels 
beginning with 
'C' and ending 
with 'E'. 
Result: 
CF Status.CLF 
Mode, 
CL Last Event 
Code, 
CL Override, 
CL Press Line, 
Corrected 
Distance, 
CR Status.Cruise 
Etc. 
 

Filter: *LAP* 
Comments: 
Finds channels 
with ‘Lap’ 
anywhere in the 
name. 
Result: 
Elapsed Lap 
Time, 
Elapsed Time, 
Lap Distance 
Etc. 

Filter: ????? 
Comments: 
Finds channels 
of 5 characters 
long. 
Result: 
EN RPM, 
G Long, 
G Vert 
Etc. 
 

Filter: Damper?? 
Comments: 
Finds channels 
that start with 
the word 
Damper, and 
are followed by 
two characters. 
Result: 
Damper FL, 
Damper FM, 
Damper FR, 
Damper RL, 
Damper RM, 
Damper RR 
Etc. 
 

 
3.1.7 Changing Channel Properties 
The Channel properties explorer - press  +   - is used to view and edit channel 
properties, which affect how a channel’s data will be plotted on the display. As with the 
Channel Explorer, channel groups appear at the top of the pane.  
 
In the Global Channel Properties explorer, all available channels and groups are in view. 
Properties edited here affect the whole Workbook, not just the display in focus. 
 

 



 

12 

In Display Channel Properties explorer, only those channels that are being displayed by the 
active display are in view. Properties edited here, will only affect the display in focus, 
overriding those set for the Workbook in the Global Channel Properties explorer. 
 

 
 
3.1.8 Saving and opening a workbook 
A Workbook layout can be saved using the button or File > Save / Save As.  
A saved Workbook can then be opened and used again when Toolbox is restarted. To open 
a saved Workbook, click the  button and browse to the location where the Workbook 
was saved. 
 
3.2 The Explorer 
The Explorer is where you create tasks, load outing datasets, select channels from the 
outings to display and edit the channel properties. When you have finished work in the 
Explorer it can be quickly hidden to maximize the screen area for data analysis. 
 
The Explorer can be navigated using the shortcuts in the table below. 
 
ß Explorer bar layout à 
Shortcut Alt+1 Alt+2 (cyclic) Alt+3 (cyclic) Alt+4 (cyclic) 

Window Task Channels 
List 

Events 
List 

Global Channel 
Properties 

Display Channel 
Properties 

Global Event 
Properties 

Display Event 
Properties 

 
3.2.1 The Task Explorer 
Pi Toolbox opens with the Task explorer in view. This is where tasks are created. Tasks are 
a convenient method of storing outing data. You create a task by right clicking in this pane 
and selecting the 'Add Task' option. When you highlight a task, its properties (Color Name 
and Description) are displayed underneath in the Details pane. 
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3.2.2 Task Properties 
Task properties are displayed in the details pane when a task is highlighted or selected.  
 
Appearance 
Color: The identifying color of the task. Double-click the color panel to select another 
color from the color palette. 
 
Description: Double-click to enter a short description of the task. Press Enter to close 
the dialog. 
Name: Double-click and type a name for the task. Press Enter to close the dialog. 
 
Auto Update 
Using the Auto Update command, a task can be made to watch a directory for new 
outings. The task will automatically Add the outing or Replace the current outing, 
depending upon the parameters set. In this way displays can be updated with the latest 
data downloaded to a network server. 
 
Enabled: Click Enabled and select Yes or No from the drop-down list to 
enable/disable Auto Update. 
 
Source: Click Source, then click the browse button. Use the Browse for Folder dialog 
to locate the watched directory. You can type the path to a directory that does not 
currently exist in the text field below the explorer view. 
Note: A dialog box will be displayed telling you that the path cannot be found. You must 
click Yes to enable the path. 
 
Target - Use the Target property to determine how Auto Update responds to new 
outings. Click Target and select an option from the drop-down list. 
 
Data selection caption: The outings added to the current task are listed 
here. When the selected outing is updated in the source directory, the task is 
updated. 
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Add Always: Any new outing added to the source directory will be added to 
the task. 
Add Initial: This is the default option. The latest dataset added to the source 
directory will be added to the task. The target will then be set to that outing. 
 
Time regions 
Initial Selection: Use the selection property to specify what time region is to be 
displayed from a data selection added to a Task, or replacing an existing data 
selection in a task: 
 
Fastest Lap: Displays the fastest lap from the outing. 
 
All regions: Displays the complete outing. 
 
Last Region: Display the lap leading up to the last lap marker. 
 
Unchanged: As outings are updated or added, the current time region selected will 
not be changed. 
 
Comparison: Designates the task as a Comparison task so multiple outings can be easily 
compared.  
 
3.2.3 Outing Properties 
Outing Properties are displayed in the lower Details pane when an outing is highlighted in 
the upper pane. Properties can be listed in categories, which you can expand or collapse, 

or listed alphabetically. To change modes select: > alphabetic/categorized. 
 
Appearance 
Color: The default color of the outing. When two or more outings are contained in a 
task, all channel traces will take on the default color of the outing it is contained in. 
This does not affect the individual properties of channels. 
 
Data Selection: Displays the outing caption and the data (Lap/s) selected for display. The 
outing caption can be configured in the Outings tab of the Options dialog. Select: 
Tools > Options to open the dialog. 
 
Details 
There are several properties in the Details section that can be changed, such as Driver 
Name and Track Name. This information is included in display print-outs. 
 
Comments 
Short Comments / Long Comments: Double-click to enter a short and/or long comment. 
Note: Long comments can be more than one line. You can also insert a carriage return by 
using Shift + Enter. The long comment will be displayed as a tooltip when there is insufficient 
space in the Task Explorer. 
 
Lap Information 
Lap Information is not editable. 
 
Outing 
Outing Information is not editable. 
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Data 
 
Show Hidden Regions: Double-click and choose Yes or No to show/hide hidden 
regions e.g. Warm up and Cool Down laps. 
 
Time Offset: When the task contains more than one outing, a time offset can be 
added to change the position of one outing relative to another. Double-click, enter a 
time offset then press Return. Offset can be set manually in a Time/Distance Chart. 
 
3.2.4 The Channels/Events Explorer 
The available channels of data and events contained in the loaded outings are listed in the 
Channels and Events windows (press  +  to cycle between the channels and events 
windows) . These include channels and events from outings as well as math channels and 
soft events created in Pi Toolbox.  
 
The Selection Explorer is used to select channels that are to be presented on displays in the 
Display Area. The filter can be used to narrow down the channels and can be used by 
typing when the selection explorer is in focus. The lower Details pane shows you which 
channels and events are selected for individual displays.  
 
The Details pane also allows you to order the channels in the selected displays in ascending 
or descending alphabetical order or manually move these with the up and down arrows, 
highlighted in the red box below. 
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3.2.5 The Channel Properties Explorer 
The Channel properties explorer is used to view and edit channel properties, which affect 
how a channel’s data will be plotted on the display. As with the Selection Explorer, 
channel groups appear at the top of the pane. 
 
There are two Channel Properties Explorer windows, Global and Display which can be 

cycled through with the  +  shortcut: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• In the Global Channel Properties window, all available channels and groups are in 

view. Properties edited here affect the whole Workbook, not just the display in focus. 
 

• In Display Channel Properties tab, only those channels that are being displayed by 
the active display are in view. Properties edited here, will only affect the display in 
focus, overriding those set for the Workbook in the Global Channel Properties 
window. 
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The following properties can be changed for channels 
 

- Appearance 
Color: The channel's default (or base) color. 
 
Color Gradation: Enables a channel’s plotted color to be graded according to the channels 
value at that point.  
 
Display name: The channel name. 
 

- Plot 
Autoscale: Enables/disables Autoscale. When Autoscale is on the trace expands to the full 
extent of the axis relating to the channel’s data, to maximize the data in the plot area. 
 
Auxiliary axis: Enables or disables multiple axes to be displayed on Time and Distance 
charts, Histograms, etc. A display will show a Y-axis for the active channel and a Y-axis for 
any channel it has selected having this property enabled. 
 
Display maximum: The maximum extents of the axis relating to the channels data when 
plotted on a display. This parameter is disabled when Autoscale in on. 
 
Display minimum: The minimum extents of the axis relating to the channels data when 
plotted on a display. This parameter is disabled when Autoscale in on. 
 
Interpolation: Determines the interpolation technique applied between sample points. 
Select either Linear or Sample and hold. 
 
Y-axis percent enabled: Enables or disables Y-axis percent of the channel. When enabled, 
the Y-axis percentage occupied by the channel and its vertical position on the scale can 
bechanged. 
 
Y-axis percent max/min: determines the maximum and minimum percentage of the Y-axis 
occupied by the channel. Use this to move a channel trace clear of other overlaid traces 
to aid visibility. 
 

- Alarm 
Alarm color: The alarm’s color. 
 
Alarm condition: Determines the threshold condition for which the alarm is triggered. The 
options are none, minimum, maximum and both. The alarm can be configured to trigger 
when the channel value drops below the minimum value, when the channel value rises 
above the maximum value or when both minimum and maximum alarm values are 
exceeded. 
 
Alarm maximum: the threshold value that the channel value must exceed above for the 
alarm to be triggered. 
 
Alarm minimum: The threshold value that the channel value must exceed below for the 
alarm to be triggered. 
 

- Data 
Decimal Places: The number of decimal places to which channel values are displayed. 
Quantity: What the channel is measuring, for example pressure, velocity. 
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Units: °C, MPH, KPH, liters, mm, bar, volts. 
- Filter 

Filter: Select a filter type from the drop-down list. The default options are: No filter, bandpass 
filter, gating-function filter, and moving average filter. When a filter is selected the Filter 
Enabled: Indicator changes to Yes. Custom filters developed using the SDK will also appear 
in the drop-down list. 
 
Filter enabled: Indicates filter on or off state. 
Filter Properties: Double-clicking this property opens the Property dialog for the filter type 
selected. 
 
3.3 Display Types 
The most commonly used display types are summarised below. 
 
3.3.1 Time/Distance Displays 
Let you display data against time or distance.  
 

 
 
3.3.2 X-Y Displays 
Lets you plot one channel against another 
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3.3.3 Histograms 
Show data in percentage and time values between specified boundaries. 
 

 
 
3.3.4 Reports  
Used for analyzing trends during outings. They can be designed for specific analysis 
requirements; stored and re-run with any outing.  
 
Excel Outing Report 
Layout and printing is performed in Microsoft Excel. Excel allows easy manipulation of 
data, and the development of complex report integration using comprehensive 
mathematical and statistical functions. 
 
Tabular Outing Report 
The Tabular Outing report shows channel values lap-by-lap for the entire outing and is 
ideal if you want to analyze trends during an outing; for example, engine temperatures or 
pressures. 
 

 
 
Split Report 
The Split report is based on the track sections. Each track section is marked by a split 
beacon point. This can be a physical beacon or a beacon inserted using the software. By 
dividing the track into appropriate sections you can see how fast and consistent the driver 
is in each section of the track. By comparing laps you will notice how adjustments made to 
the setup affect performance. 
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Creating a Split report using elapsed time gives a very useful Split Time report. The Split 
Time report provides two unique performance indicators: the theoretical fastest lap and the 
fastest rolling lap. 
The theoretical fastest lap gives the lap time that could be achieved if the best split section 
times from an outing were all in one single lap. 
 
The fastest rolling lap is the fastest lap time using a start and end point, which may not be 
the end-of-lap beacon. Comparing achieved lap times to the theoretical fastest lap time 
shows driver consistency. 
 
Event Report 
Event reports show when an event occurred and any associated channel values. 
 
3.3.5 Maps 
Show a pictorial representation of the track, built from logged data. 
 
3.3.6 Aerial Map Display  
GPS tracked coordinates over a satellite image. 

 

 
 

3.3.7 Video Displays  
Enable MPEG files to be viewed in synch with Task Cursor time. 
 
3.3.8 Bit Indicators 
Examine system status channels looking for error conditions. 
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3.3.9 Channel Displays 
Display the numeric values of the selected channels for real time (last point) or historic data. 
 

 
3.3.10 Event Displays 
Display events from both real-time and historic data, depending on the type of data stream 
it is associated with. 
 

 
 
3.3.11 Chart Recorders 
Display real-time data from the car as it proceeds around the track. The chart constantly 
updates with the latest data, resulting in a scrolling behavior. 
 
3.3.12 Navigators  
Provides a quick and easy means of selecting time regions within outings, changing the 
range of data plotted by displays connected to the same task. 
 

 
 
3.3.13 Dash Display 
Allows Real-time and PDS file playback of Cosworth device displays. 
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4. Math Channels and Soft Events 
 
4.1 Introduction to Math Channels and Soft Events 
 
Pi Math allows users to perform complex data analysis. Generally a math channel takes one 
or more input channels and produces an output channel. Input channels can be real 
channels or other math channels. 
 
The operators and functions that are available to math channels are also available to soft 
events. Soft Events are simply math channels with a Boolean value. For a given sample point, 
if the event occurs, it is On/True. If the event does not occur it is Off/False. For 
Example: [Speed]>80. 
 
4.1.1 What is a math channel? 
A greater understanding of performance can be gained by combining ‘real’ channel data, 
mathematical equations and functions to create a Math channel. These can be thought 
of as user generated ‘virtual’ channels derived from the result of a mathematical operation. 
Math channels can be used in the same way as real channels. The results can be displayed 
in the Time and Distance displays, Histograms, Reports etc. 
 
A Math channel is identified in the explorer like this:  Math Channel Name. 
 
A simple math channel is in the form of: 
Math Channel = ƒ (Input1, Input2,) 
Calculating the aerodynamic downforce that the car is subjected to is a typical math 
channel: 
 
TotalAero = AeroF + AeroR 
 
Where: 
 
AeroF = FL Pushrod Load + FR Pushrod Load 
 
AeroR = RL Pushrod Load + RR Pushrod Load 
 
TotalAero is a math channel whose inputs, AeroF and AeroR are also math channels. 
These, however, are derived from the input data (real) channels: FL Pushrod Load, FR 
Pushrod Load, RL Pushrod Load and RR Pushrod Load. 
 
4.1.2  What is a soft event? 
Engineers need to create their own events based on set conditions within channel data, for 
this purpose soft events are provided. Unlike hard events, which are part of the outing data, 
soft events are always calculated at run time. For example, on a circuit test to investigate 
the efficiency of the gearbox oil pickup, when the car is accelerating, braking, stationary 
and not cornering conditions need to be excluded. Setting event parameters to exclude 
lateral acceleration data greater that 0.5g or less than –0.5g and the RPM data greater 
than 10,000rpm, would be carried out in the Soft Events Management dialog. 
 
A soft event is identified in the explorer like this:  Soft Event Name 
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4.2 Creating and Editing Math Channels and Soft Events 
 
Equation strings for math channels and soft events are created in the Equation field of the 
Management dialogs.  
 
Select: Tools > Pi Math > Edit or Tools > Soft Events > Edit. 
A new channel is created by pressing the  button. 
Building equations is facilitated by built-in mathematical functions and operators.  
Selection of the operators or channels is made from a drop-down list, accessed by pressing 

 in the equation field. 
 
To select, use the up/down arrow keys to highlight the required operator and press Enter. 
The Channel or Operator is inserted in the equations at the cursor location. The list can be 
filtered if required. The backspace key will delete filter characters. The content of the drop-
down list depends upon the context of the equation when accessed: 
 

• After '[' or between '[' and ']' a list of available channels is displayed.  
 

 
 

• Between two sub-expressions a list of operators is displayed. 
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When highlighted, or with the cursor held over, a tool tip shows the syntax and description 
of the operator. 

Note: Enter a space after the ']' character, before pressing , to access the 
list of operators. 
 
Operands 
The following objects may be used as operands in the equation: 

• Channels 
• Global math constants (name) 
• Outing constants (name) 

 
 

Constants 
Constants are referenced using the following syntax:  

• CONST (Constant name) 
• GLOBALCONST (Constant name) 
• OUTINGCONST (Constant name) 

 
Error Checking 
The Status bar beneath the equation field displays ‘Definition evaluates successfully’ or 
‘invalid Definition‘ as you build the equation, to indicate the accuracy of the equation 
syntax. 
 
An invalid definition is also indicated by the math channel icon, which changes from  

for a valid definition to for an invalid definition. 
 
 
Examples 
 
Shown below is an example of a valid Pi Maths definition definition. 
 
 
 /* True if Down Paddle Pressed when a Downshift is not allowed  
If entered as a maths channel the ouput of the channel will be 1 when the logic evaluates to True, if 
entered as a Soft-Event an Event will be created instead*/ 
 
register @a0; 
register @a1; 
 
@a0 = choose([ecu_B_paddn]>@a1 && [math_downshift_allowed]==2, 1, 0); 
@a1 = [ecu_B_paddn]; 
 
@a0 
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4.3 Pi Maths Operators and Functions 
 
4.3.1 Operators 
The following table defines the operators, which are supported in precedence order. 
 
Operator Usage Description 
   
Unary  associate right to left 

- -x unary negation 
! !x logical negation:  if x is not zero result is zero, else 1 
~ ~x bitwise not:  inverts every bit in x cast as a 32 bit integer 

Multiplicative  associate left to right 
* x*y returns the product of x and y 
/ x/y returns the dividend of x and y.  If y = 0, then returns zero. 

Additive  associate left to right 
+ x+y calculates the sum of x and y 
- x-y calculates the difference of x and y 

Shift operators  associate left to right 
<< x << n shifts x cast as a 32 bit integer left n bits 

>> x >> n shifts x cast as a 32 bit signed integer right n bits, sign extending 
the result 

Comparisons  associate left to right 
> x > y returns 1 if x > y else 0 

>= x >= y returns 1 if x >= y else 0 
<= x <= y returns 1 if x <= y else 0 
< x < y returns 1 if x < y else 0 

Equality   
== x == y returns 1 if x equal y else 0 
!= x != y returns 1 if x not equal y else 0 

Bitwise  associate left to right 

& x & y Casts x and y to a 32 bit integer, and then bitwise AND’s the 
two results. 

| x | y Casts x and y to a 32-bit integer, and then bitwise OR’s the two 
values. 

Logical  associate left to right 
&& x && y returns 1 if both x and y are non zero else zero 
^^ x ^^ y returns 0 if x and y are both non zero or zero, else 1 
|| x || y returns 1 if either x or y are non zero else 0 

 
4.3.1 Functions 
The following table defines the functions, which are supported. 
 

Function Usage Description 
rand  Random value 0.. 1 

Transcendental   

acos acos(x) 
The acos function returns the arccosine of x in the range 0 to 
p radians. If x is less than –1 or greater than 1, acos returns an 
indefinite (same as a quiet NaN). 
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asin asin(x) 
The asin function returns the arcsine of x in the range –p/2 to 
p/2 radians. If x is less than –1 or greater than 1, asin returns an 
indefinite (same as a quiet NaN).  

atan atan(x) atan returns the arctangent of x. If x is 0, atan returns 0. atan 
returns a value in the range –p/2 to p/2 radians. 

atan2 atan2(x, y) 

atan2 returns the arctangent of y/x. If both parameters of 
atan2 are 0, the function returns 0. atan2 returns a value in 
the range –p to p radians, using the signs of both parameters 
to determine the quadrant of the return value.  

sin 
sin(x)  
x in 

radians 

sin returns the sine of x. If x is greater than or equal to 263, or 
less than or equal to –263, a loss of significance in the result 
occurs. 

cos 
cos(x) 

x in 
radians 

as sine but calculates the cosine 

tan 
tan(x) 

x in 
radians 

tan returns the tangent of x. If x is greater than or equal to 263, 
or less than or equal to –263, a loss of significance in the result 
occurs, in which case the function generates a _TLOSS error 
and returns an indefinite (same as a quiet NaN).  

sinh 
sinh(x) 

x in 
radians 

sinh returns the hyperbolic sine of x. If the result is too large, 
sinh returns ±HUGE_VAL.  

cosh 
cosh(x) 

x in 
radians 

as sinh 

tanh 
tanh(x) 

x in 
radians 

tanh returns the hyperbolic tangent of x 

exp exp(x) 
The exp function returns the exponential value of the floating-
point parameter, x, if successful. On overflow, the function 
returns INF (infinite) and on underflow, exp returns 0. 

hypot hypot(x, y) hypot returns the length of the hypotenuse of the triangle 
specified by x and y if successful or INF (infinity) on overflow.  

log log(x) The log functions return the natural logarithm of x if successful. 
If x <= 0, returns 0. 

log10 log10(x) The log functions return the logarithm base 10 of x if 
successful. If x <= 0, returns 0. 

pow pow(x, y) 
returns x to the power of y, except when: 
(x=0 and y<=0) or  (x<=0 and y is not integral) in which case 0 
is returned. 

sqrt sqrt(x) The sqrt function returns the square-root of x. If x is negative, 
sqrt returns 0.  

Conversions   

ceil ceil(x) The ceil function returns a double value representing the 
smallest integer that is greater than or equal to x.  

floor floor(x) The floor function returns a double value representing the 
largest integer that is less than or equal to x. 

fabs fabs(x) returns the absolute value of x. 

fmod fmod(x/y) fmod returns the floating-point remainder of x / y. If the value 
of y is 0.0, fmod returns 0.  

min min(x, y) returns the lesser of x and y 
max max(x, y) returns the greater of x and y 
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shr shr(x, n) converts x to a 32 bit unsigned  integer, and shifts the bits right 
n bits, shifting in zeroes in the high order bits 

choose choose(c, 
x, y) 

if (c is 1) returns x otherwise returns y 

s8 s8(x) returns x casts to a signed byte 
u8 u8(x) returns x cast to an unsigned byte 
s16 s16(x) returns x cast to a signed word 
u16 u16(x) returns x cast to an unsigned word 
s32 s32(x) returns x cast to a signed dword 
u32 u32(x) returns x cast to an unsigned dword 

 
4.4 Pi Math Channel Management 
 
The Pi Math Management dialog allows the following properties to be edited for the Math 
Channel. 

 
Channel List 
This is a list of all existing math channels. When a math channel is highlighted in the list, its 
details are displayed in the panels on the right. 

 Inserts a default name for a new math channel in the math channel list. 
Deletes the math channel currently highlighted in the math channel list. 

 
Note: You can select single or multiple channels in this list using ‘Shift + Click’ or ‘Ctrl + Click’. 
 
Alternatively select all channels by pressing ‘Ctrl + A’. With multiple selections, filtering will 
deselect non-matching records, whilst the matching records remain selected. 
 
CAUTION: A math channel may be a sub-expression of another math channel equation, i.e. 
the math channel is dependent on another. Deleting the first channel would cause the 
dependent channel to become globally non-valid. 
 
Name 
Displays the name of the math channel highlighted in the channel list. The name can be 
edited in this field. 
CAUTION: Math channel names are case sensitive. Make sure that you do not create a 
math channel that has the same name as an existing one, but different capitalization. 
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Quantity/Unit 
Math channel units default to user-defined units. These are entered directly in the Unit field 
of the Pi Math Management dialog. 
A math channel's quantity can be changed to a pre-defined quantity in the extended 
section of the dialog. When the quantity is defined, the user can then define the unit. 
 
Rate 
Math channels consist of one or more input channels that are usually acquired at different 
frequencies. 
 
The user determines the Calculation or Sampling Rate of a math channel, which can either 
be the same rate as one of the constituent channels, or user defined. 
 
Inherit rate from: Allows you to select from a drop-down list, which contains the constituent 
channels of the equation. The calculation rate of the math channel will be the same as the 
data rate of the channel selected here. 
 
Fixed: Allows you to define a data rate from a range of fixed frequencies from 1 to 1000 Hz. 
This option can be used when a math channel has no constituent real channels. 
 
Equation 
This field is for entering the math channel equation string. 
 
The syntax is color highlighted as follows: Red = error, Green = comment, blue = keyword. 
If required, a description may be added to aid identification. Insert the description between 
the characters: /*Description Here*/, or after the characters: //Description Here 
Note: The status bar beneath the equation field displays ‘Definition evaluates successfully’ 
or ‘Invalid Definition’ as you build the equation, to indicate the accuracy of the equation 
syntax. 
Input Channels 
The input channels list is a list of all real channels referenced in the math channel equation. 
Here you can change the quantities and units of individual channels. Simply double-click a 
quantity or unit, and select from a drop-down a list of options appropriate to the channel. 
 
Note: The Default Properties panel on the right of the Management Dialog is used to define 
math channel properties. The properties displayed are those of the channel selected in the 
Channel Name list. These properties appear in the Properties Explorer and determine the 
appearance of the math channel trace in displays. 
 
4.5 Importing and Exporting Math Channels 
Math channels can be imported to and exported from a Workbook from Tools > Pi Math > 
Export/Import 
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4.6 Lookup Tables 
 
Lookup tables are contained in external excel files. Tables can be included in math channel 
and soft event equations by mapping to the external table with a definition string. 
There are two table types: 1 input parameter (1D) and two input parameters (2D). Data is 
linearly interpolated between values. 
 
1D Lookup Table: 
 

 
2D Lookup Table: 
 

 
 

4.6.1 Lookup Table Syntax 
Both 1D and 2D tables are defined in the math channel/soft event equation using the 
following syntax: 
 
table #name = path\filename\sheet\!cellfrom:cellto; 
 
Where: 
 
Table: Keyword is used for defining lookup tables 
 
Name: Is the lookup tables name. It must always start with a '#' symbol. 
 
Path: Is the driver plus directory path of the Excel file. Relative network paths can also be 
used. See the examples below. 
 
Sheet: Is the Excel sheet name. 
 
Cellfrom: The lookup table's top/top left value cell. 
 
Cellto: The lookup table's bottom/bottom left value cell. 
 
Cellto and Cellfrom arguments can be specified using the Excel Cell syntax, e.g. cell A3 
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would be $A$3. 
 

 
 

4.6.2 Lookup Table Usage 
Lookup Tables can be used in channel/event definitions with the following syntax: 
 
#name (exp[,mode]) 
#name (exp1, exp2[, mode]) 
 
Where: 
 
Name: Is the name of the table. 
 
Exp: Is the input argument used in 1D lookup tables 
 
exp1 and exp2 - are input arguments used in 2D lookup tables. exp1 specifies the 
IndexColumn and exp2 the IndexRow. 
 
Mode: Is optional parameter. It specifies modes of interpolation/extrapolation. If not 
specified explicitly, the 'Snap' value will be assumed. It can have one of the following 
value. 
Interpolation: Interpolation is performed 
 
Extrapolation: Extrapolation is performed. 
 
Both: Interpolation and extrapolation is performed. 
 
Snap (default value): neither interpolation or extrapolation is performed - the nearest 
value 
is returned. 
 
Hold: As Snap mode but will snap the value always to the previous one. 
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4.7 Registers 
 
4.7.1 What is a register? 
Registers are used for storing discrete variables (real numbers). The value of a register after 
the current sample is evaluated, is propagated as a value for the next sample evaluation. 
Registers are calculated for each sample of the math channel. Typical uses of registers are 
to: 

• Simplify equations by providing means for defining local variables. For example: 
 
AveSpeedFront = ([SpeedFL] + [SpeedFR]) / 2 
 
AveSpeedRear = ([SpeedRL] + [SpeedRR]) / 2 
 
(AveSpeedFront + AveSpeedRear) / 2 
 

• Make recurrent definitions by persisting registers sample-by-sample. For example: 
 
Summ = Summ + [Speed] 
 
Will set Summ equal to the value of Summ in the previous sample plus the value of the 
Speed channel in the current sample. 
 
4.7.2 Working with Registers 
 
Declaration 
Before a register can be used it must be declared, for example: register @R; 
 
Register names are case sensitive and must start with the ‘@’ character. 
 
As part of the declaration the user can specify an initial value for the register: 
 
Register @R=1; 
 
When not specified, initial value defaults to zero. 
 
Note: Register declarations must precede all other statements in an equation. 
 
Initial Value 
 
A register takes its initial value only for the first sample of the math channel (which is 
equivalent to initialization of static variables in C++). 
 
Assignment 
Once a register is declared, its values can be changed with an assignment operator: 
 
<register> = <expression>; 
For example: @R = @R + 1; 
 
Registers in expressions 
The value of registers can be used in any expression by simply specifying the register name: 
Sin( @R); 
@R3 = log (@R1+@r2); 
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4.8 Pup-Up Alarms 
 
4.8.1 What are Pup-Up Alarms 
Pop-Up Alarms are visusal indicators that certain channels have reached a defined value. 
When this happens a pop up window will appear that requires acknowledgement.  
 
4.8.2 Configuration  
Pop-up alarms configuration is accessed via the Tools menu (real-time license is required for 
this feeature): 

 
 

The configuration dialog contains two tabs, one for configuring global qualifiers, another for 
configuring the individual alarms.  The qualifiers tab takes inspiration from Toolset’s logic 
channels editor, here only supporting channel and bit-field comparisons are available.  
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Individual alarms are configured using an editor inspired by Toolset’s alarms editor. It’s 
possible to select which of the global qualifiers should also be applied to each alarm, and 
to enable/disable the alarms. 
For “Channel” conditions, the channel database alarm min/max values will be set as the 
default comparison value when selecting ‘<’, ‘<=’ or ‘>=’, ‘>’ comparisons. 
 

 
 

It’s possible to configure the headline message that gets displayed when the alarm triggers, 
with “Custom Text” allowing an arbitrary string to be entered 
 

 
 
4.8.3 Triggered Alarms  
Triggered alarms are shown on a pop-up dialog and that has the following features: 
 
Can be configured to always be on top of other windows. 
 
Allows  multi-selection of  multiple triggered alarms by clicking the entries, or using the 
checkboxes, and then dismiss those selected alarms. 
 
It’s not be possible to manually close the dialog, it will close automatically once all alarms 
are dismissed. The dialog will persist its position on closing, and restore to its previous position 
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when displayed.  If the previous monitor becomes unavailable, it will revert to displaying on 
the monitor on which the main Pi Toolbox window is displayed. 
 

 
 

4.8.4 Import/Export 
It’spossible to import and export pop-up alarm definitions via the Tools menu.  These entries 
will bring up “standard” Toolbox import/export wizards.  
 

 
 

4.9 Constants 
 
4.9.1 What is a constant? 
A constant is a named, time-invariant value that has a global or outing context. 
 
Constants can be used in math channels; for example, if several math channels use a spring 
rate value, that value can be represented by a constant created in Pi Toolbox. If the spring 
rate needs to be changed, by changing the constant value to the new rate, all channels 
using the constant are recalculated using the new value. 
 
4.9.2 Types of Constant 
 
Global Constants 
A global constant has scope across all datasets and is saved as part of a Workbook. They 
are available for all Math Channels. Constant values, for instance: tire diameter, which do 
not change from one outing to the next, are defined as Global Constants. 
 
Outing Constants 
An outing constant only has scope within an outing and is saved as part of a dataset. 
Constant values, for instance: track temperature, which can change from one outing to the 
next are defined as outing constants. 
 
Simple constants and Excel constants 
There are two constant variants: 
 

• Simple Constant: Which is defined as a numeric value 
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• Excel Constant: Which takes its value from an Excel cell. When math channels 
containing the constant are calculated, the value is taken from the spreadsheet cell, 
for example, a component value in the setup sheet. Certain actions can be 
executed in Excel before the cell value is retrieved, e.g. Execute a Macro. 

4.9.3 Constants Management 
Global constants and outing constants are defined in the Constants Editor. The scope of 
the constant depends upon where the value is entered in the Editor. 
 
To open the dialog, select: Tools > Constants > Edit 
 

 
 

 Inserts a default name for a new constant in the constants list. 
Deletes the constant currently highlighted in the constants list. 

 
Names - The constants that exist for the current Workbook or for any of the outings 
contained in the Workbook are listed in the Name column. Change the name of a constant 
by double-clicking the default name and typing in a new name. 
 
Global - A constant value entered here creates a Global constant. Enter a value by double-
clicking in the Global field and typing. 
 
Outing - The columns following the Global column represent the outings currently loaded in 
the Workbook. A constant value entered here creates an Outing constant. Values are 
entered by double-clicking in the Outing field and typing. 
 
4.9.4 Excel Constants 
The Constants Editor is extended when the 'More' button is pressed. These commands are 
used for creating Excel Constants. 
 
The left window shows details of the constant currently highlighted in the main window of 
the dialog. To create an Excel Constant, select Excel in the Type field and enter the name 
of the Excel workbook to be used. Then enter the cell address of the cell holding the 
constant value, into the Cell field, using the standard Excel format. 
 
Excel cell: Enter the location of the cell which holds the constant value, the location is in 
the form: Sheet name! A1 or A1, (column letter, row number). 
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Excel file: Opens a browse dialog to let you browse for the Excel File. 
 

 
 
Command: The right hand window gives further command and argument options. 
Commands are activated each time Pi Toolbox attempts to acquire a value from a cell 
before the value is read. You can add as many commands as you wish and change their 
order using the up/down arrow buttons. To add a command, right-click in the Commands 
column and select from the available list. 
 
Enter arguments by typing directly in the field. 
The commands available are: 
 
Move to Sheet: Activates an Excel Sheet (argument: sheet number) 
 
Execute Macro: Executes an Excel Macro (argument: Excel Macro Name) 
 
Set Cell Value: Sets a value in a cell in the active Excel Workbook (argument: A1=value). 


